PHOENICS Case Study: HVAC
Air Flow and Solar Radiation

PHOENICS/FLAIR, with a structured computational mesh, was employed, by the T C Chan Centre for Building
Simulation and Energy Studies in Pennsylvania, USA, to create the following replication of a pseudo-3D tutorial
example for the built environment.
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Modelling goals:

Outdoor wind flow into indoor space.
Heat source to change the inlet temperature of wind as application of modern wind tower.

Solar radiation outside as another heat source from natural system - Wind Speed and Distribution of
heat to indoor and surrounding.

Although it is straightforward to set up the geometry of such a case using PHOENICS ‘primitives’, in this
scenario the building design in question has been imported from CAD as a DWG format file.

The facility exists within PHOENICS/FLAIR to read weather data prevailing for any particular location from an
external data file such as EnergyPlus. In this example, the wind direction and solar gain values are individually
specified via the menu. The 2D representation of the building in question is as follows:
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Fig. 16. Wind tower integrated with wetted columns or clay conduits.
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Starting a new model in PHOENICS

In the VR-Editor, go to File > New case. Select FLAIR as the interface best suited for this type of
application\simulation.



Pre-processing

Set the model domain size through the main menu > geometry. This can be done as indicated below.

@ FLAIR - VR Editor February 2013 Single Precision - 64 bit

File Settings View Run Options Compile Buid Help

D|e{a/m/B|&| < poan e a2 [ 018 o] “ols [wRHTZTH[0] £ €[N 2 -

MAIN @ wegtor | % |

MENU |

Paosition
-n 500000 1.},
= KX

Size

X -SEI 00000 4 .},
Y -m ooooo [ .p,

No title has been set for this run.

Grid Mesh Settings

Co—-ordinate system Time dependence

Cartesian Steady

Partial solids treatment on | settings |

X-Manual | Y-Manual | Z-Manual

Domain size [30.00000 [10.00000 [12 . 00000

Number of cells [ 151 [ 1 [ 76

Tolerance [1.000E-3 [1.000E-3 [1.000E-3

No of regions | 5 ‘ 1 ‘ 4

Modify region [ 1 [ 1 [ 1
size [ 6.45674a3 [ 10.00000 [ 3.050000

Distribution Power law | Power law | Power law ‘

Cell _power set | Free | sSet ‘

Cells in region | 20 ‘ 1 ‘ 25

Power/ratio [-1.300000 [1.000000 [1.000000

Symmetric No | No | No ‘

Edit all regions in X direction| ¥ direction| z direction]|

Cancel ApPly
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Object] Action  View Group
New v Mew Object | visibility | Wireframe |2
Copy object(s) Import CAD Object on on

on on

on on

Select All Import Object on on

Array object(s) Import CAD Group

on on
. on on
Refresh Plotting Surface an an

Close BELOCKAGE cubeld on on
d T

Clear All Clipping plane
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To create new object, select New ocbject from Object menu




Select New Object and set object type to Sun object. Then, by clicking attributes, the following panel appears,
for which relevant data can be specified.

Sun Attributes

Get North and Up from No
Angle between North and Y 0.000000 <

Use weather data file No
Latitude |[0.698000 °

Direct Solar radiation From sclar altitude

Diffuse Solar radiation From solar altitude ‘ Clear sky

Date (dd/mm/yy) 21 Jun 2012

Time (24hr) [ 11 h |

Oopticonal extra ocutput

Cancel

@ Object Management

[Object] Action  View Group
New v New Object | Visibility | Wireframe | Affe
Copy object(s) Import CAD Object on on vy

Array ohject(s) Impaort CAD Group
Select All Import Object
Clear All Clipping plane
Refresh Plotting Surface

Close |
I J 0

To create new object, select Mew object from Object menu

Once it is selected, the following screen will appear. We have the option to scale the CAD object in question,
which can be useful if units used for the CAD file are not in metres (PHOENICS default is to use Sl units.)

Geometry Import

Read 130 points and 404 facets

The original size and positiocn are:

dx 1.585360E+00 dy 6.717100E-01 dz 1.000000E+00
x0 6.456750E-01 yO 0.000000E+00 =zO 0.000000E+00

Take size from Geometry file Yes

Take position from Geometry file No

Geometry scaling factor 1.000000 Apply
CAD X ¥ Z align with VR X ¥ =

Object constrained by domain Yes

Cancel




Once imported, clicking on attributes displays the following screen: The desired material can be selected, along
with its roughness and its solar absorption factor.

Blockage Attributes

Material: 121 Concrete block (mediumweight)

Types: Solids

Roughness Default 0.000000
Wall function law Default

Slide Velocity: Stationary

Energy Source: Adiabatic

Heat transfer coeff Wall function
Solar absorxption 0.200000

Initial Temperature No

InForm Commands

From the same Obj menu we can then add the remaining objects. First we will add an inlet. Select New object
and from the drop-down list and select Inlet.

Inlet Attributes.

Act as: Export No Import No
Nett area ratio 1.000000

Inlet density is Domain fluid ‘

at an Ambient| pressure of: 0.000000 Pa

relative to 1.013E+05 Pa

Temperature Ambient 27.50000 °c

Method Velocities
X Direction FETEEEEEE___ m/s
Y Direction ’W m/s
Z Direction [0.000000  m/s

Inlet turbulence: Intensity

Turb. intensity 5.000000 s

InForm Commands

Clicking attributes we can modify the inlet conditions.

Size and place are then modified and set to fill the entire left-side of the domain (using "to end" option), with
an object position of (0, 0, 0).

Ohbject Specification

General] Options] Size P|ELCB _i| Shape ]

Ohject position, m Rot'n angle about axis, deg

» | 0.000000 EI: [ atend » | 0.000000 EI:
Y | 0.000000 EI: [ atend Y | 0.000000 EI:
Z |0.000000 3: [ atend Z |0.000000 EI:

[0]4 | Cancel | Feset | Apply |




Likewise, an Opening (or outlet) object must be added on the far right of the domain. This is a pressure
boundary, with flow through it governed by the difference in pressure inside the domain and the external
reference pressure (normally set to ambient pressure). The position of this outlet is set to X "at end" or at 30m.

Opening Attributes

Act as: Export No Import No
Nett area ratio 1.000000
External Ambient| pressure 0.000000 Pa

Relative to 1.013E+05 Pa

Coefficient 100.0000 Linear

External wvalues (used ONLY when inflow)

External temperature is: User-set

Text Ambient 27 .50000 °c

External turbulence is: In-cell

Velocity X User-set | [o-oocoooo0 m/s
vVelocity ¥ User-set | [o-ooocooo m/s
Velocity Z User-set | [o-oooooo m/s

InForm Commands

Object Specification

General] Options] Size Shape ]

Object position. m Fot'n angle about axis. deg

* | 30.00000 3 v atend » | 0.000000 3:
v | 0.000000 EI: [~ atend v | 0.000000 EI:
£ | 0.0oo0ooo EI: [~ atend Z | 0.000000 Eli

[8]:4 | Cancel | Feset | Apply |

[Note that if this were a 3D simulation, it would be easier to use the Wind object to define the external
boundary conditions through a single user panel.]

Wind Attributes

Use weather data file No

External density is: Domain £luid

External pressure [101325.0  Pa
Coefficient [1000.000 Linear
External Temperature [27.s0000  ~c

Wind speed [10.00000 = m/s

Wind direction North [0 000000  °
Reference height [10.00000  m

Angle between North and ¥ [0.000000  °

Profile Type Logarithmic
vertical direction z
Effective roughness height
o oo | [2.000E-2 =
Include open sky No

Include ground plane No
Store Wind Amplification Factor (WAMP)

Cancel




To model the cooling effect of the chimney due to a water spray, a blockage of Domain material type is added.
This will overwrite any solid regions which happen to overlap, and in this case implies the thin vertical plates
within the CAD geometry. Clicking Attributes we can change the material of the object to Domain Material,
which in this case is air.

A Linear Heat Source source is added with a value (or temperature) set to 15°C, and a coefficient, which
establishes the extent that this temperature is to be enforced, ie a large value of 1.0+E07 would ensure air
passing through the patch is fixed at 15°, while a lower value such as 100 will allow more variation, dependent
on the coefficient multiplied by the difference between the specified value and local temperature of the air.

Blockage Attributes

Material: 2 Air using Ideal Gas Law, STP

Types: _Domain Material |

Enexrgy Source: Linear Heat Source

Coefficient 100.0000 Value 15.00000

Other Sources: Momentum Source
Initial Values

Porosities
InForm Commands

In addition to this a momentum source is set to restrict flow to the Z direction only and apply a small sink using
a Quadratic Source to provide a pressure loss based on velocity squared via an approprate coefficient.

Momentum Source

X direction: Fixed Velocity

value 0.000000 m/s

¥ direction: Fixed Velocity

value 0.000000 m/s

Z direction: Quadratic Source

Coefficient 1.000000 value 0.000000

One more object is necessary for this model, and that is the Ground terrain. It is added in the same fashion as
the objects above, selecting Plate as the type of object, sizing it to cover the entire XY plane and located at
(0,0,0). This object will provide the no-slip condition for the ground, and boundary layer development for a

smooth surface.

@ Object Management
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With the geomety set up, the domain settings are applied.

Clicking the Menu button on the control panel, and navigating to Models allows the turbulence model to be

selected, and ensures the energy equation is solved (FLAIR default settings are fine).

Domain Settings

Geometry | | Froperties | Initialisation | Help |

Top menu |

Souzces | Numezics | cutput

Equation formulation Elliptic-Staggered |

Lagrangian Particle Tracker (GENTRA) OFF

Solution foxr wvelocities and pressure

Energy Equation TEMPERATURE

Turbulence models KECHEN

settings |

Radiation models OFF

Fan operating point OFF

System cCurve OFF

Comfort indices settings

Solve sSpecific humidity OFF

Solve s=moke mass fraction OFF

Seolution control / Extra wvariables settings
InForm — Group 7 Edit InForm 7

The domain material is set to Air using Ideal Gas Law, which allows for temperature and density variations and

ambient conditions to be set.

Domain Settings

Geometry ‘ Models ‘ ‘ Initialisation ‘ Help Top menu ‘

Sources | Numerics | output

Domain material:

The current domain material is Air using Ideal Gas Law,

STF

Edit properties of current material

Property storage

Reference pres (Pa) 101325.0 Temperature units Centigrade
Ambient pressure o Ambient temperature 27.5
Initialise from ambient ON Set buoyancy from ambient OoN

Prandtl/schmidt Nos settings InForm - Group 92 Edit InForm 9

C

Buoyancy is set in the Sources panel. This option is set automatically to the Density Difference method if FLAIR

is used.

The option to have buoyancy affect turbulence can also be set in this panel (eg for fire/smoke modelling).

Diomain Settings [ ]

Gecmetry | Models | Properties | Initialisation | Help | Top menu

Numerics ocutput

Gravitational forces oN

Buoyancy model is DENSITY_ DIFFERENCE

Gravitational x ¥ z

acceleration [0.o00000 0.000000 -9.810000

Reference density (kg/m"3) (Daduced from Ambiant conditions)

Buoyancy effect on turbulence OFF ‘

Cyclic boundary conditions  ALL_SLABS_OFF

Coesff. for auto wall functions LOG-LAW

Global wall roughness 0.000000 m

Page Dn| Line Dn




Solver conditions are set under Numerics. These include the total number of iterations to be performed, the
type of differencing scheme to be used and the settings of any relaxation parameters.

Domain Settings

Geometry ‘ Properties ‘ Initialisation | Help Top menu ‘

output

Total number of iterations 4000
Minimum numbexr of iterations 1
Maximum runtime Unlimited

Global convergence criterion 0.010000 %

Sources

Relaxation control ‘ Iteration control |

Limits on Variables ‘ Differencing Schemes

Multi-Grid Accelerator - MIGAL ‘

Edit InForm Group is5 16 17 18

Convergence accelerator for highly compressible flow:

The default option for relaxation is Automatic Convergence Control (CONWIZ): On. This is a convergence wizard
that automatically sets the relaxation parameters to try to ensure convergence. If it is switched off, experienced
users can set parameters manually, which can lead to faster run times using less conservative relaxation values.

Domain Settings

Relaxation Settings Previous panel |

Automatic Convergence Control Reset =s=clution defaults |

variable  >| [P1 [u1 (w1 [KE EP

RELAX LINEAR | FALSDT FALSDT LINEAR LINEAR

VALUE [1.000000 [0.100000 |0.100000 |0.500000 |0.500000
MAXINC [1.000E20 [100.0000 [100.0000 [0.100000 [1000.000

Reference wveloccity 10.00000 Reference length 1.000000

Aute calculation of residual normalising factors

SELREF | RESFAC |1.000E-4

PHOENICS creates automatically a Cartesian mesh across the whole domain. It uses a cut-cell algorithm called
PARSOL (PARtial SOLids) to analyse which parts of a given cell are occupied by fluid and solid regions. This
reduces greatly the complexity of generating a mesh for any given case.



Clicking the mesh button on the control panel displays the mesh overlaid on the domain. Each of the regions
(created by objects affecting the grid and denoted by orange lines on the mesh display) can be modified
individually by clicking them and changing the desired parameter on the Grid Mesh Settings panel.

In certain regions it might be beneficial to crush the mesh using non-uniform spacing to reduce the overall cell
count. Both Power and Geometric Progression distributions are available, with power/ratio settings <-1 for
diminishing and >1 for increasing mesh spacing.

Once the desired mesh is obtained, the solver can be run. To commence the run, select Solver from the Run
menu tab.

Grid Mesh Settings

Co-ordinate system

Cartesian

Partial solids treatment

Domain size
Number of cells
Tolerance

No of regions
Modify region
Size
Distributien
Cell _power
Cells in region
Power/ratio
Symmetric

Edit all regions i

Cancel

Time dependence

Steady

on |

Settings |

X-Manual |

Y-Manual |

Z-Manual

[30.00000

[10.00000

[12. 00000

| 15

FO 1

[ 76

[1.000E-3

[1.000E-3

[1.000E-3

5 1

4

2 [ 0

[ 4

[ 8.86325

Power law |

1 [ 0.000000

Power law

[ 5.282900

Power law |

Set

| Free

| Set

| 5

° [ 0

[ 20

[1.000000

No

[0.000000

| No

[1.300000

| No

X directionl ¥ direchionl zZ directionl

2pply
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A real-time plot of residuals and spot values for the probe location are printed to the screen as the run
progresses (known as a GXMONI plot). This establishes whether the solution is converging or not. As we can see
on the right hand side of the plot below, the residuals tend to be very small numbers, while the spot values on
the left remain stable as the number of iterations increases - an indication of good convergence.

Wind 1m/s from East

spot Values at ( 27, 1, % Error - Cut off 1.000E-02 %

Change Low High Variable Max % Error Change
.55E-06 -2.00E-01 2.00E-01 31 . 00E+01 . 65E-04 .61E-06
.79E-07 -4.00E-01 -2.00E-01 vl . 00E+01 .07E-03 . 44E-05
.64E-07 -4.00E-02 . 00E-02 . 00E+01 .03E-03 . 66E-05
.76E-07  0.00E+00 .00E-01 . 00E+01 . 98E-03 .41E-05
.08E-08 2.00E-02 . 00E-02 . 00E+01 .89E-03 . 06E-06
L00E+00  2.00E+01 . 00E+01 . 00E+01 . 25E-04 . 60E-08

NZ ISWEEP 3995 TIME Press a character key
76 IZSTEP OFF Working to interrupt.

Post-processing

Once the run has completed with satisfactory convergence, select GUI, from the Post-Processor tab (also under
the Run menu tab). Clicking the C button on the control panel opens the contour plot options.
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Vectors can be used in conjunction with, or instead of contour plots by selecting them from the Vector tab.

Use of the Sun object provides the option to plot certain related field variables such as #Sol (Solar absorption
factor), #QS2 (Total heat source per unit cell) or LIT (lllumination flag).
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These can be accessed from the Current Variable drop-down menu.

Full post-processing guidance can be found by clicking on the PHOENICS-VR Reference Guide:
http://www.cham.co.uk/phoenics/d polis/d_docs/tr326/tr326top.htm
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